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控制理论基础 MATLAB 语言仿真实验 

第一部分     MATLAB 入门 
（一）  MATLAB 的启动和退出 

启动： 1.  双击桌面上的 MATLAB6.5 的快捷方式图标 即可。 

2.  开始→程序→MATLAB6.5 文件夹→单击  MATLAB6.5。 
退出： 1.  直接单击界面的关闭图标“×”即可退出 MATLAB。 

         2.  选择菜单 File→Exit  MATLAB。 
 
 
（二）  MATLAB 的操作界面 

      启动 MATLAB6.5 后进入右图      
MATLAB6.5 的缺省外貌。界面上铺放着 4
个最常用的窗口： 
命令窗口（Command Window）, 
工作空间（Workspace）, 
命令历史窗（Command History）, 
当前路径窗口（Current Directory）, 

 
 
 

第二部分  SIMULINK 仿真基础 
（一） SIMULINK 的启动 

1. 在 MATLAB 命令窗口中输入 simulink 后

回车。 
2. 单击 MATLAB 界面工具栏的 图标。 

进入 Simulink Library Browser 模块浏览

器（见右图） 
 

（二） SIMULINK 常用模块库介绍 
    1.   连续模块库（Continuous） 

 Integrator(积分模块)：输入信号的

连续时间积分。该模块将输入信号

进过数值积分，在输出端直接反应

出来。 
模块功能：对输入变量进行积分。 

         说    明： 
          （1）输入的信号即可以是标量，也可        
               以是矢量。 
          （2）输入信号的维数必须与输入信号           
               保持一致。 
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 Derivative(微分模块)  数值微分 
         该模块将输入端的信号经过一阶数值 
         微分，在输出端输出。 

         模块功能：通过计算差分
du
dt

近似计算 

            输入变量的微分。 du 为输入变量， 
         dt 为自前一次仿真以来的时间变化量。 
         说    明： 
          （1）模块的输入可以是标量，也可以是矢量。 
          （2）在仿真开始前的输入信号值假设为 0，模块的初始输出为 0。 
          （3）微分结果的准确性取决于仿真步长，步长越小，输出结果越精确。 

 Transfer-Fcn  (传递函数模块)：分子分母形式的线性传递函数模块。 
传递函数常用来描述频域下的线性微分方程，是线性化的一种时域描述。 

         模块功能：用于执行一个线性传递函数。 
         说    明： 
          （1）传递函数的一般形式。 
          （2）分母的多项式就是系统的特征多项式。 
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 Zero-Pole(零极点传递函数模块)：以零极点表示的传递函数模型 
         该模块用于实现一个特定的零极点系统。 
         模块功能：用于建立一个预定的零点、极点，并用延始算子 S 表示的连续系统。 
         说    明： 
          （1）系统的零点、极点或为实数，或为共轭复数形式出现。 
          （2）此模块的设置为： Zeros 参数设置零点矢量；Poles 参数设置极点矢量；Gain 参

数设置增益系数。 
    2.  Math  Operation（数学模块） 

 Sun：求和模块 
              用于对多路输入信号进行加减运算，

并输  出结果。 
 Product：乘法模块 

用于实现对多路输入信号进行乘积、

商、矩阵乘法或模块的转置。 
 Gain：增益模块 

用于把输入信号乘以一个指定的增益因子，

使输入产生增益。 
 Trigonometric Function：三角函数模块 

用于给输入信号施加一些常用的三角函数运算，包括正弦、余弦、正切等。 
说明：用户可以从 Function 表中有 11 种三角函数供选择，分别是：exp、log、10u、log10、
square、aqrt、pow、reciprocal、hypot、rem、mod。 

 Math Function：常用数学函数模块 
用于给输入信号施加一些常用数学函数运算。 

说明：用户可以从 Function 表中有 10 种三角函数供选择，分别是：sin、cos、tan、asin、
acon、atan、atan2、sinh、cosh、tanh。 

3. Signal  Routing（信号线路模块） 
 Mux：将多个单一输入转化为一个复合输出。 
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 Demux：将一个复合输入转化为多个单一输出。 
4. Sinks（接收器模块） 

 Scope：示波器。 
用于显示输入信号与仿真时间的关系曲线，仿真时间为 X 轴。Scope 模块可以有多

个显示坐标（每个端口一个），允许用户调整时间量和输入值的显示范围，用户也可以

移动和调整模块窗口的大小，并且可以在仿真时间内修改 Scope 模块的参数。 
 XY  Graph：二维信号显示模块 

用于在 MATLAB 图形窗口上显示一个二维图。模块有两个输入，模块根据 
         输入的第一个数据（X 方向）和第二  

个数据（Y 方向）绘图。 
5. Sources（输入源模块） 

 Constant：输入常数模块 
该模块的输出是一个与时间无关

的常数，该常数可以是实数，也可以

是复数。 
 Pulse  Generator：脉冲信号 
该模块用于产生固定频率的脉冲

序列。 
 Ramp：斜波信号 

该模块指定初始时间、初始幅度

和变化的斜波信号。 
 Signal  Generator：信号发生器 
该模块用于产生正弦、方波、锯

齿波等三种不同的波形。 
 Sine  Wave：正弦波信号 
该模块产生一个正弦曲线。 

 Step：阶跃信号 
该模块可在指定时间产生一个

可定义上下电平的阶跃信号。若仿真

时间小于 Step  time 参数值，模块输

出为 Initial value 参数值。对于大于或等于 Step  time，输出为 Final value 参数值。该

模块根据参数的长度产生一个标量或矢量输出。 
 
（三） SIMULINK 功能模块的处理 

1. 拖曳模块：模块库中的模块可以直接用

鼠标进行拖曳（选中模块，按住鼠标左

键不放）而放到模型窗口（见右图）中

进行处理。 
2. 移动：选中模块，按住鼠标左键将其拖

曳到所需的位置即可。若要脱离线而移

动，可按住 shift 键，再进行拖曳。 
3. 复制：选中模块，然后按住鼠标右键进

行拖曳或在 Edit 菜单下的 copy 即可复

制同样的一个功能模块。 
4. 删除：选中模块，按 Delete 键或在 Edit 菜单下的 Clear 即可。若要删除多个模块，可以

同时按住 shift 键，再用鼠标选中多个模块，按 Delete 键或在 Edit 菜单下的 Clear 即可。

也可用鼠标选取某区域，在按 Delete 键就可以把该区域中的所有模块和线等全部删除。 
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5. 转向：为了能够顺序连接功能模块的输入和输出，功能模块有时需要转向。在菜单 Format
中选择 Flip Block 旋转 180 度，选择 Rotate Block 顺时针旋转 90 度。或者直接按住 Ctrl+F
键执行 Flip Block，按住 Ctrl+R 键执行 Rotate Block.。 

6. 改变大小： 选中模块，对模块出现的 4个黑点标记进行拖曳或在View菜单中选Zoom  In
放大（Zoom  Out 缩小）即可。 

7. 模块命名：先用鼠标在需要更改的名称上单击一下，然后直接更改即可，名称在功能模

块上的位置也可以变化 180 度，可以用 Format 菜单中的 Flip Name 来实现，也可以直接

通过鼠标拖曳。Hide Name 可以隐藏模块名称。 
8. 颜色设定：Format 菜单中的 Foreground Color 可以改变模块的前景颜色，Background Color

可以改变模块的背景颜色；而模块窗口的颜色可以通过 Screen Color 来改变。 
9. 参数设定：用鼠标双击模块，就可以进入模块的参数设定窗口，从而对模块进行参数设

定。参数设定窗口包含了模块的基本功能帮助，为获得更详尽的帮助，可以点击其上的

help 按钮。通过对模块的参数设定，就可以获得需要的功能模块。 
 

（四） SIMULINK 信号线的处理 
SIMULINK 模型的构建是通过用信号线将各种功能模块进行连接而构成的。用鼠标可

以在功能模块的输入与输出端之间直接连线。所画的线可以改变粗细、设定标签，也可以

把线折弯、分支。 
1. 改变粗细：信号线所以有粗细是因为线引出的信号可以是标量信号或矢量信号，当选中

Format 菜单下的 Wide Vector Lines 时，信号线的粗细会根据信号线所引出的信号是标量

还是矢量而改变，如果信号是标量则为细线，若为矢量则为粗细。选中 Vector Lines Widths
则可以显示出向量引出线的宽度，即向量信号由多少个单一信号组成。 

2. 设定标签：只要在信号线上双击鼠标，即可输入该信号线的说明标签。也可以通过选中

信号线，然后打开 Edit 菜单下的 Signal Properties 进行设定，其中 Signal Name 属性的作

用是标明信号的名称，设置这个名称反映在模型上的直接效果就是与该信号有关的端口

相连的所有直线附近都会出现写有信号名称的标签。 
3. 信号线的折弯：按住 Shift 键，再用鼠标在要折弯的信号线处单击一下，就会出现圆圈，

表示折点，利用折点就可以改变信号线的形状。 
4. 信号线的分支：按住鼠标右键，在需要分支的地方拉出即可。或者按住 Ctrl 键，并在要

建立分支的地方用鼠标拉出即可。 
5. 模块与信号线的分离：将鼠标放在想要分离的模块上，按住 Shift 键，再用鼠标把模块拖

曳到别处，即可将模块与信号线分离。 
6. 信号线的分割：先选中信号线，按住 Shift 键，然后在信号线上需要分割的点上单击鼠标

左键。此时，信号线就在此点上被分割为两段，拖曳新节到适当的位置，然后松开左键，

则新节点就被移动到新的位置上。 
7. 移动节点：选中要移动的节点，则鼠标指针形状变为圆形。拖曳节点到新的位置，放开

鼠标，则新节点就被移动到新的位置。 
8. 信号线的删除：选中信号线后按 Delete

键即可。 
9. 信号线的移动：选中要移动的信号线，拖

动鼠标到指定的位置即可。 
 

（五） SIMULINK 仿真的运行 
  运行一个仿真的完整过程分成三个步骤：

设置仿真参数，启动仿真和仿真结果分析。 
1. 设置仿真参数和选择解法器 
      设置仿真参数和选择解法器，选择
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Simulation 菜单下的 Simulation  Parameters 命令，就会弹出一个仿真参数对话框，如右图所

示， 
它主要用五个页面来设置仿真的参数： 
（1） Solver 页：此页可以进行的设置有： 

选择仿真开始和结束的时间；选择解法器， 
并设定它的参数；选择输出项。 

○1 仿真时间（Simulation time） 

       缺省时的起始时刻为 0.0s，终止时间为 10.0s。 
  只要在 Start time 和 stop time 文本框内输入新的数 
值即可修改仿真时间。 

○2 仿真步长的模式（Solver options） 

     用户在 Type 后面的第一个下拉选项框中指定仿真的步长选取方式。可供选择的 
有 Variable-step（变步长）和 Fixed-step（固定步长）方式。 

变步长模式解法器有：ode45，ode23，ode113， ode15s， ode23s， ode23t ，
ode23tb 和 discrete。ode45 是缺省值。 

固定步长模式解法器有：ode5 ，ode4 ，ode3， ode2，ode1 和 discrete。ode5
是缺省值。 

○3 步长参数 

 对于变步长模式，用户可以设置最大的和推荐的步长参数，缺省情况下，步长自

动的确定它由值 auto 表示。 

□a Maximum step size（最大步长参数）： 

    它决定了解法器能够使用最大的时间步长，它的缺省值为“仿真时间/50”即整个 
仿真过程中至少取 50 个取样点。 

□b Initial step size（初始步长参数）： 

    一般建议使用“auto”默认值即可。 

□c Mininum step size（最小步长参数）： 

    一般建议使用“auto”默认值即可。 
 对于定步长模式，可以设置固定步长的大小与任务模式。 

 Fixed step size（固定步长参数）： 
一般建议使用“auto”默认值即可。 

○3 仿真精度的定义（对于变步长模式） 

 □a Relative tolerance（相对误差）： 

     缺省值为 1e-3，表示状态的计算值要精确到 0.1％。 

□b Absolute tolerance（绝对误差）： 

    表示误差值的门限，或者说在状态值为零的情况下，可以接受的误差。如果它被 
设成 auto，那么 simulink 为每个状态设置初始绝对误差为 1e-6。 

2. 启动仿真 
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      ○1 选择 simulation 菜单下的 start 选项来启动仿真，如果模型中有些参数没有定义，则

会出现错误信息提示框。 

      ○2 单击模型窗口工具栏的 图标。 

 
（六） 控制系统建模及仿真举例 

1. 启动 MATLAB。 
2. 在命令窗口中输入 simulink 后回车（或单击 MATLAB 界面工具栏的 图标），进入

Simulink Library Browser 模型库浏览器界面窗口。 
3. 在 Simulink Library Browser 窗口下，选择 File→New→Model,打开一个新的模型窗口。根

据要求在 File→Save as…下另取文件名。 
4. 添加模块 

 
 从连续模块库（Continuous）拖曳二个函数模块（Transfen Fcn）到模型窗口。 
 从数学操作模型库（Math Operations）中拖曳比例模块（Gain），再拖曳一个求和

模块（Sun）到模型窗口。 
 从输入源模块库（Sources）中拖曳一个阶跃模块（Step），再拖曳一个时钟模块

（Clock）到模型窗口。 
 从接受模块库（Sinks）中拖曳一个示波器模块（Scope）,再拖曳二个传送到 MATLAB

工作空间模块（To Workspace）到模型窗口。 
将各模块之间按要求连线得到下图 

 
5.  分别双击各模块，出现对话窗口根据要求

分别输入参数（注意空格的特点）。 
6.   选 择 菜 单 Simulation → Simulation 

Parameters,弹出 Simulation Parameters
对话框，设置仿真停止时间等参数。 

7.    选择菜单 Simulation→Strat 命令运行模

型，双击仿真示波器模块（Scope），弹出

示波器窗口显示仿真后的瞬态响应曲线。 
8.    用线性定常系统 LTI Viewer 仿真。选择

菜单“Tool \ Linear Analysis”，将弹出

“Model-Inputs-and-Outputs”窗口（见右图）和线性定常系统可视化仿真环境 LTI Viewer：
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examplel 窗口。若已建的模型中含有为给定值的参数，将弹出一错误对话框，告诉哪些参

数未定义 
 
9．加入输入输出点：去掉原模型图中的阶跃

模块（Step），时钟模块（Clock），二个传

送 到 MATLAB 工 作 空 间 模 块 （ To 
Workspace），和示波器模块（Scope），把

“ Model-Inputs-and-Outputs” 窗 口 中 的

Input point 和 Output point 分别拖入模型

窗口（见名为 untitled 的模型图） 
10．运行：选择菜单 Tools \ Linear Analysis，

弹出线性定常系统可视化仿真环境 LTI 
Viewer：untitled 窗口。选取 LTI Viewer：
untitled 窗 口 菜 单 “ Simulink \ Get 
Linearized Model”。出现阶跃响应曲线 

 11.改变传递函数的参数：不关闭 LTI 
Viewer：untitled 窗口，激活 untitled
的模型窗口。双击要改变参数的模块

成员块，修改参数后，返回 LTI 
Viewer：untitled 窗口，选择“Simulink 
\ Get Linearized Model”后，便以不同

颜色给出对应的响应曲线， 
12．变换响应曲线类型：LTI Viewer：

untitled 窗口能方便、直观、准确地根

据不同地要求绘制相应地阶跃响应曲

线（Step）（缺省曲线类型）、脉冲响

应曲线（Inpulse）、Bode 图（开环、

闭环）、Nyquist 图和 Nichols 图等。在

LTI Viewer：untitled 窗口绘图区单击

右键，将弹出一快捷菜单，选择快捷

“Plot type \ Bode”出现对应地 Bode
图（用不同颜色显示修改参数前后所

有对应参数的曲线图）。 
13.获取性能指标：在 LTI Viewer：untitled

窗口的绘图区域，单击鼠标右键，将

弹出一快捷菜单。选择快捷菜单中的

“Characteristics \ 选项”，将对已绘出
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的曲线标记特征值：如过渡过程时间（Setting Time）、上升时间（Rise Time）、进入稳态

时间（Steady state）、峰值点（Peak Response)等，鼠标点击并按住标记点，将显示该点特

征值。 

 
14.设置坐标有关参数值：选取 LTI Viewer：untitled 窗口菜单“Edit \ Viewer preferences”，
弹出“LTI Viewer preferences”窗口，在里面可以对 LTI Viewer 窗口里面的坐标单位、稳

态误差范围等进行定义设置，见上右图。 
15.改变坐标值：选取 LTI Viewer：untitled

绘图区鼠标右键 \ Preferences，在 Limits
选项卡里可以设置 X、Y 轴的坐标范围，

见右图。 
16.显示多种类型曲线：选择“Edit \ Plot 

Configuration”,设置同时显示相应曲线的

种类和布局，见右图。 
      设置同时显示阶跃响应、波特图。点

击绘图区鼠标右健 \Grid，将画上网格线。 
17.输出频率响应曲线：在 LTI Viewer：

untitled 窗口中，选择菜单 “File \ Print….” 
  。LTI Viewer：untitled 窗口中曲线图形立刻从打印机输出。 
     选择菜单“File \ Print….”曲线图形输

出到 Figure 窗口中，在该窗口可以对曲线

图形进行注释、改变特征值标记式样及其

大小、打印设置和在 Edit\copy Figure 拷贝

到其他文档中。 
18.修改标记点式样及大小：选取 Figure 

No.1:LTI Viewer Responses 对话框中工具

栏图表“↖”，曲线处于可编辑状态，双

击标记点，弹出“Property Editor”对话框，

设置线宽、线型、标记点大小和标记点形

状，见图。 
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第二部分     MATLAB 实验 
 

实验一    时域仿真： 

   A 、典型环节与典型系统的仿真： 

1． 实验目的及要求： 

   a . 熟悉各典型环节的输出阶跃响应曲线，并改变系统参数 K、T、 , nξ ω (将

传递函数中用字母表示的参数用具体数据代入)，观察输出阶跃响应曲线的变

化,理解参数对系统性能的影响。同时将阶跃响应曲线画在（手工作图）实验

指导书上，并写出对应的传递函数 G（S）。 
b. 将仿真曲线所得的传递函数有关数据与输入数据对照，分析仿真误差，

并分析原因。 
c.  用线性定常系统 LTI Viewer 再进行仿真，仿真结果打印曲线并分析

曲线。 
d. 了解使用 MATLAB / SIMULINK 进行时域特性分析的方法。 

       2.  实验设备： 
         a.  计算机            1 台 
         b.  MATLAB6.5       1 套 
         c.  U 盘              1 个 
         d.  打印机            1 台 
 

3.  实验内容： 
     启动 MATLAB 然后在 MATLAB 的提示符下，键入 SIMULINK 并回车。

此时在桌面上显示一个包括有MATLAB命令窗口和SIMULINK的LIBRARY: 
SIMULINK 的窗口界面。启动 SIMULINK\FILE\OPEN 在 U 盘中分别建立以

下模型图，并对其进行阶跃信号仿真和用线性定常系统 LTI Viewer 仿真。 
 
a.  比例环节( P )：    文件名：Gain.mdl 
      仿照下图，建立比例环节模型图 

 
1. 双击 Gain 模块，分别改变 Gain 的值 K（K=5、10、20）。 
 
2. 启动 Simulation\Start，双击 Scope 模块跳出 Scope 窗口，并显现比

例环节阶跃响应曲线。用 Simulation\Stop 停止。 

3. 观察分析不同 Gain 值的阶跃响应曲线，并画在实验指导书上（见后
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页，曲线画在同一坐标上），写出对应的传递函数 。 
 
b.  积分环节( I )：    文件名：Integrator.m.mdl 
     仿照下图，建立积分环节模型图 

 
1. 双击 Transfer Fcn 模块，分别改变分母的”T”值（注意数字之间要有

空格），当 T=1、5、50 时的斜率变化。 
 
2. 启动 Simulation\Start，双击 Scope 模块跳出 Scope 窗口，并显现积

分环节阶跃响应曲线。用 Simulation\Stop 停止。 
 
3.  观察分析不同 T 值的阶跃响应曲线，并画在实验指导书上（见后页，

曲线画在同一坐标上），写出对应的传递函数 。 

 
c. 比例加积分( PI )、比例加微分( PD )、比例加积分加微分( PID )： 文

件名：PID.mdl   
仿照下图，建立比例加积分加微分模型图 

 

1.    分别打开 Gain、Gain1、Gain2、Transfer Fcn2 模块并输入 Kp、Ki、Kd、
T 的值，  当 Kd=0 时，此时系统为比例加积分( PI )，当 Ki=0 时，此时系统

为比例加微分( PD )，当 Kp、Ki、Kd 的值不为零时，此时系统为比例加积分

加微分( PID )。 
 
2.    启动 Simulation\Start，双击 Scope 模块跳出 Scope 窗口，并显现例加积分

( PI )、比例加微分( PD )、比例加积分加微分( PID )阶跃响应曲线。用

Simulation\Stop 停止。 
 
3.    分别观察比例加积分( PI )、比例加微分( PD )、比例加积分加微分( PID )

的阶跃响应曲线，并画在实验指导书上 , 写出对应的传递函数 。 
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d. 惯性环节：  文件名：Order1.mdl 
仿照下图，建立惯性环节模型图 

 
1.   双击 Transfer Fcn 模块，将具体数值代入方框图中的时间常数 T,

分别改变时间常数”T”值（注意数字之间要有空格）。 
 
2.   启动 Simulation\Start，双击 Scope 模块跳出 Scope 窗口，并显现

惯性环节阶跃响应曲线。用 Simulation\Stop 停止。 
 
3.    分别观察不同”T”值时的阶跃响应曲线，将不同“T”值的阶跃响

应曲线画在下列表格中(画上坐标及坐标单位)。请在各图上标明 T 的

值 。同时分析（用文字说明）不同时间常数对曲线的影响。（如取

T=0.02、0.05、0.1、0.2、0.5、1、2、5 秒）, 写出对应的传递函数 。 
 

  T =   T =   T =   T = 

    

 
G(S) = 

 
G(S) = 

 
G(S) = 

 
G(S) = 
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  T =   T =   T =   T = 

    

 
G(S) = 
 

 
G(S) = 

 
G(S) = 

 
G(S) = 

 
 

e. 二阶系统： 文件名：Order2.mdl 
仿照下图，建立二阶系统模型图 

图中的参数 T1、T2、k 用具体数值代入 

 
1. 分别双击 Transfer Fcn、Transfer Fcn１、Gain 模块，分别改变分母

的”T”值或 Gain 的 K 值（注意数字之间要有空格）。使   ξ< 0、ξ

＝0、0<ξ<1、ξ＝1、ξ>1。 
 
2. 启动 Simulation\Start，此时跳出 Figure 窗口，并显现二阶系统阶跃

响应曲线。用 Simulation\Stop 停止。 
 
3. 分别观察在ξ< 0、ξ＝0、0<ξ<1、ξ＝1、ξ>1 值时的阶跃响应曲

线，将ξ< 0、ξ＝0、0<ξ<1、ξ＝1、ξ>1 的曲线画在下列表格中

(画上坐标)。请在表中写出传递函数，标明ξ的值 ,同时分析不同阻

尼ξ的值对系统的影响。 
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 示范：根据模拟电路利用 Simulink 进行自动控制原理实验的仿真。 
 
   二阶系统的阶跃响应实验 
其模拟电路如图 1 所示。 

 
 
系统的闭环传递函数为： 

   
  典型二阶系统的闭环传递函数为： 

    
  由式(3)可知，改变比值 R2/R1，可以改变二阶系统的阻尼比 ζ，改变

RC 值可以改变无阻尼自然频率 ωn。 
二阶系统电路的结构如图 2 所示。 

 
利用 Simulink 建立仿真框图如图 3 所示。 

根据阻尼比 ζ在不同的范围内取值，二阶系统的单位阶跃响应对应的运动

规律如下。 
(1) ζ < 0，响应发散，系统不能正常工作。 
 
(2) ζ ＝ 0，系统以最快的速度进入稳态，但响应曲线是等幅振荡的。 
 
(2) 0 < ζ < 1,虽然响应有超调，但是上升速度比较快，调节时间比较短。 工
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程上把阻尼比 ζ ＝0.707 的二阶系统称为二阶最优系统。 
 
(4) ζ ≥ 1，响应与一阶系统相似，没有超调，但调节速度慢，进入稳态需要

较长时间， 二阶系统单位阶跃响应曲线如图 5 所示。 
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其中，ζ<0 对应的是(R2/R1)<0，这在实际中是无法实现的，因为实际中

的电阻值 为正，通过 Simulink 仿真可以解决这一问题。 
    通过仿真实验，学生在具体实践操作时，可以分别选择 R2=0 kΩ,140 
kΩ,200 k Ω和 400 kΩ进行实际实验操作。这样可以更好地实现“理论指导实

践，实践反映理论”的目的。 
 

以上典型环节再用线性定常系统 LTI Viewer 仿真。 
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    B 、阶跃响应测定传递函数法： 
 实验目的及要求： 
1. 掌握由单位阶跃响应曲线近似求取一阶、二阶系统传递函数的实验

测定。 
 

2. 打印一阶或二阶系统的阶跃响应曲线并在曲线上标出

时间常数 T 写出相对应的传递函数。 
 

 实验内容及方法： 
1. 在做惯性环节时，任取一时间常数 T。在 Scope 窗口中显现惯性环

节阶跃响应曲线。 
2. 根据典型一阶系统惯性环节 

      （式 1） 

 
所经过的时间 t，既为此统惯性环的瞬态响应理论分析可知， 
当 t=T时其响应曲线 y(t)=1-exp(-t/T)(t≧0) 的上升值y(T)=1-e

-1
=0.632。

因此可以从曲线上升到稳态值的 63.2%节的时间常数 T，这样也就能写

出此惯性环节的具体传递函数表达式。 
3. 在做二阶系统时，取ξ<1 欠阻尼阶跃响应曲线。在 Figure 窗口中显

现二阶系统欠阻尼阶跃响应曲线。将曲线打印在纸上，并在曲线上

将曲线打印在纸上，并在曲线上标出超调量 Mp 及过度时间 ts以及

写出传递函数。 
二阶震荡欠阻尼系统(0<ξ<1)， 

      
（式 2） 

 
它的传递函数另一种表达式 

（式 3） 

 

从曲线上测得单位阶跃响应曲线的超调量 

 （式 4） 
及过渡时间 ts(到达稳态误差 2%所经过的时间) 根据公式： 

               同样也能写出二阶系统传递函数具体表达式。 

         （式 5） 

         （式 6） 

 



 20

n

T
ω
1

=

4. 根据上面的公式以及 

 

     （式 7）    
和公式（8）试讨论 ts、Mp 与 T1、 T2、 
 
                                        

K 的关系，并将具体数据代入方框图中做实验，打印曲线分析论证。 
打印方法有两种 : 根据方框图中所设定的 To  Workspace 和 To  
Workspace1 中的时间变量及输出变量(变量名可自定)，当 Start 后已将

数据传入 MATLAB 空间，在 MATLAB 提示符下键入命令 plot(时间变

量名，输出变量名)回车后出现 Figure 窗口并显现刚才 Scope 中的曲线，

在 file\print 确定后既打印图形。另一种即 Figure 窗口 file\save 取名在存

盘。 
 
 
 
 

环节 

名称 
代号 

瞬 态 曲 线  

(请在图中将坐标及单位标出) 

对应具体的传递函数

G(S)= 

 
 
 

比例 

 
 
 

P 
 
 
 

  

 
 
 

积分 
 

 

 
 
 

I 
 
 

  

 

比例 

积分 

 
 
 

PI 
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比例 

微分 

 

 

 

PD 

 

 

 

  

 

比例积

分微分 

 

 

 

PID 

 

 

  

二 阶 系 统 瞬 态 响 应 曲 线 (请在图中将坐标及单位标出) 

ξ<0 ξ=0 0<ξ<1 
响 应 曲 线 响 应 曲 线 响 应 曲 线 

写 出 各 对 应 响 应 曲 线 的 阻 尼 值 和 对 应 的 传 递 函 数G(S) 

  ξ=     T=   ξ=      T=   ξ=    T= 
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T1=    ,T2=     ,K=    

 

G(S) = 

T1=    ,T2=     ,K=    

 

G(S) = 

 

ξ＝1 ξ>1  

响 应 曲 线 响 应 曲 线  

写 出 各 对 应 响 应 曲 线 的 阻 尼 值 和 对 应 的 传 递 函 数G(S) 

  ξ=     T=   ξ=      T=  

T1=    ,T2=     ,K=    

 

G(S) = 

T1=    ,T2=     ,K=    

 

G(S) = 
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1
24

T
KTξ =

实验二、频率特性的测试： 

1． 实验目的及要求： 
a. 通过对二阶系统频率特性测试，体会频率特性的物理意义。（说明：对未知传

递函数的系统频率特性测试方法相同） 
b. 由频域仿真所得的一阶、二阶系统的仿真曲线，分别画出（手工作图）对应

的对数频率特性图（伯德图）并确定它们的传递函数 G(S)。 
c. 用线性定常系统 LTI Viewer 再进行仿真，仿真结果打印曲线并与手工作图曲

线对比分析曲线误差。 
d．熟悉 MATLAB 语言及 SIMULINK 频率特性仿真的应用。 

 

2.  实验内容： 

 二阶震荡系统：   文件名：Shock.mdl 
         仿照下图，建立二阶震荡系统模型图 

将图中的参数 T1、T2、k 用具体数值代入 

 
          （式 8） 

1. 调定二阶系统的参数，根据公式 
使ξ<0.707 欠阻尼。 
 

2． 启动 Simulation\Start，此时在 Scope 窗口显现二阶震荡系统输入、输出正弦

波曲线。用 Simulation\Stop 停止。 
 
3.  分别双击打开 Signal Gen和 Scope的窗口，改变 Signal Gen模块中Frequency  

频率（ω）的值(窗口 Units 选择 rad/sec，窗口 Wave from 选择 sine)，并分

别观察 Scope 中的波形。找出谐振频率ωr（即输出幅度最大时所对应的输入

频率）和截止频率ωb（当输入幅度 Vr=±1 时，输出幅度下降为输入幅度的

70.7％所对应的输入频率）以及对作 Bode 图便利的各点频率。根据找出的频

率，在 Signal Gen 模块 Frequency 中分别输入各点频率，同时在 To Workspece
和 To Workspece1 模块中依次改变 Variable name 的名字如（t1~t5）、
（ww1~ww5）。 

4.   在 U 盘中分别建立二阶模型图，并对其进行频率特性仿真，检验你手工作的
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波特图是否正确！再用改变不同的ξ值用线性定常系统 LTI Viewer 仿真，打

印曲线并分析其参数的改变对 Bode 图的影响加深理解。 

 
5．在 Matlab 窗口中的提示符下，依次键入命令 plot(t1,ww1)~plot(t5,ww5)和

plot(tt1,ww1a)~plot(tt5,ww5a)观察图形，使之满意。然后分别存盘打印并分

析图形中幅值及相位的变化，手工绘制 Bode 图。 

 
6   打印方法有两种，根据方框图中所设定的 To  Workspace 和 To  

Workspace1   中的时间变量及输出变量(变量名可自定)，当 Start 后已将数

据传入 MATLAB 空间，在 MATLAB 提示符下键入命令 plot(时间变量名，

输出变量名)回车后出现 Figure 窗口并显现刚才 Scope 中的曲线，在 file\print
确定后既打印图形。另一种即 Figure 窗口 file\save 取名在存盘。 

 
7.   在实验报告相应的图上写上峰值频率ωr  截止频率ωb  阻尼比ξ 的具体

数值,并写出二阶系统具体的传递函数式。 
 

文件名 
输入频率

ω(    ) 

输入幅度

Ar 

输出幅度

Ac 

输出/输入

L (ω) 

输出与输

入相位差

Φ(ω) 

w1      

w2      

w3      

w4      

w5      

W6      

W7      

W8      

W9      

W10      
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从实验数据所得： 
    ωr （峰值频率）=         rad/sec。 
    ωb （截止频率）=         rad/sec。 
 
8. 根据谐振峰值公式和谐振频率公式： 

检查所确定的传递函数 G(S)是否正确。 
     
 根据公式所得： 
    ωr （峰值频率）=         rad/sec。 
    ωb （截止频率）=         rad/sec。 
 
分析实验数据及公式计算数据的误差： 
 
 
 
 

 

9.   写出你所仿真的二阶系统传递函数： 

(T1=     ,  T2=     ,   K=      ，)  
 

 

ξ＝  

 

T ＝  

 

 

 

G(S)=  ------------------------------------  
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   10. 将对数频率特性图（伯德图）画在下方。 
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用线性定常系统 LTI Viewer 仿真以下三组数据构成的二阶系统。从各角度分析

不同ξ值构成的三个二阶系统在阶跃响应下的输出曲线变化以及它们的频率特

性，说明其优缺点（打印曲线并在图中指出对应的传递函数）。 
1

2

2
1
1

( )

T
T
K

T
G S

ξ

=⎧
⎪ =⎪
⎪ =⎪
⎨
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⎪ =
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=⎪⎩
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